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1. Introduction 

 
 
TMS is a universal tool for seamless dataflow between the company specific IT headquarters infrastructure and the 
individual petrol stations. Even though foreseen with user interface, it is mainly meant to work 24 hours a day, all 
year long, without any need for user interference, automating all the dataflow between the sites and the central, in 
both directions. It is meant to be able to accept data in any format and provide data in any format in order to fit into 
as much as possible into the existing headquarter IT infrastructure. 
 
TMS Scheduler(s) continuously check(s) whether new actions have to be executed. It awaits triggers from various 
sources and acts upon them. Action scripts are located in the TMS database. Action scripts are managed through 
TMS GUI and or can be imported externally. Actions can be executed immediately or based on a time schedule, 
subject to an external or internal trigger. Actions are often recurrent, programmed to happen repeatedly (Every day 
but not in the weekend,…). Action completion can trigger other actions depending on the result of the action. 
Actions are station specific, or for a group of stations.  
 
Various architectures of TMS installation are available. In its most distributed form, multiple user interfaces (TMS 
GUI) operate on client machines allowing users to control multiple action schedulers residing on other machines. 
More user interfaces are useful when various users need to supervise distinctive tasks (user possibilities can vary 
depending on attributed rights…). Multiple TMS Schedulers are useful in case of huge networks with hundreds of 
sites. The benefit of using more TMS Schedulers is increase of responsiveness, higher reliability and possibility to 
dedicate distinctive tasks to a specific TMS Scheduler. This can be needed in case of heterogeneous networks 
using various communication means only available from separate physical locations.  
 
The TMS scheduler communicates with the sites using TCP/IP. Old networks using PSTN, ISDN and X25 are also 
supported. Volume of data transferred can be kept low in order to allow for fluent operation over communication 
networks with a very low throughput.  
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1. 1. TMS Scalability  

1. 1. 1. All on 1 machine 

 
In this setup, the database (DB), the scheduler (TMS Scheduler) and the user interface (TMS GUI) are all installed 
on 1 machine. 

1. 1. 2. Graphical User Interface(s) on other machine(s) 

 
In this setup, the database (DB) and the scheduler (TMS Scheduler) are installed together. 
Other machines are used to run the user interface (TMS GUI and the scheduler viewer). 
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1. 1. 3. Fully distributed architecture 

 

 
In this setup, the database is located on a server, schedulers are on separate machines and GUI’s/viewers are 
integrated into user desktops.  
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1. 2. The types of actions of TMS 

TMS is a universal tool for fully automated seamless dataflow between the company specific IT headquarters 
infrastructure and the petrol stations. It converts and transfers data between headquarter and sites.  
 
These are the different action types: 

 
• CALL  Script based data exchange with sites  

• REPORT  Generation of human readable reports of various kinds and formats 

• EXPORT  Generation of machine readable data of various kinds and formats 

• SERVICE Data Import, conversion, processing and transport. 

• QUIT  Programmed temporary termination of TMS scheduler. Can be used for external backup 
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2. Login screen 

 
 
After opening the GUI application, a login screen will pop up. It is mandatory to have a login and a password. (If 
you do not have a login and a password, you will have to contact an Administrator). 
Enter your login and password and confirm with the [Login] button. 
 
To change your password, click the [Change password] button. 

 

 
 
Enter a new password in the ‘New pw’ field and the ‘Confirm password’ field. Confirm the entry with the button 
[Write new password]. This button only appears after entering the previously mentioned fields. 
NOTE: “Login” and “Password” are case sensitive. 
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3. File menu 

3. 1. Station selection 

 
 

 
 
By selecting a station from this list, you will set up a default station. Every action is scheduled for this default 
station.  
The selected default station will be visible on the TMS main screen, as shown below. 
Use the button [Deselect] to deselect a station as default station. 
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3. 2. Group selection 

 
 

 
 
This function is similar to the one described in 1.1 Station selection. By selecting a group from this list, you will set 
up a default group. Every action is scheduled for this default group of stations.  
The selected default group will be visible on the TMS main screen, as shown below. 
Use the button [Deselect] to deselect a group. 
 

 
 
NOTE: this is the only way to define an action for a group of station. 
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3. 3. Quick action 

 
 

 
 
This is a fast way of defining an action (or several) for a certain station. The actions in the dropdown list have been 
created by the user (see: 5.3.4 Quick). 
This is a one-time action for immediate scheduling. 

3. 4. Print 

 
 
When a report, export, or logging file is shown, this line will be enabled. This function allows you to print these 
types of files. See also 3.1 Report, 3.2 Export, 3.3 Logging. 

3. 5. Exit 

 
 
This function allows you to exit the TMS application. 
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3. 6. Icon bar 

 
 
The buttons in the icon bar correspond to each line in the file menu. 
 
When a certain station or group has been selected, the number and name of this station/group appears in this bar. 
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4. Schedule menu 

To acces the list of scheduled actions, open the schedule menu. The screen below will appear.  
 

 
 

 
 
• [Add]: this button allows you to add an action to this list. 

• [Edit]: this button allows you to edit an existing action in this list. 

• [Hold]: this button allows you to put a scheduled action on hold, or to activate it again. When an action is on 
hold, it is marked with a STOP sign at the beginning of the line. 

• [Delete]: this button allows you to delete the selected action(s). Confirm with the [OK] button. 

• [Reschedule]: this button allows you to reschedule the selected action(s) depending on the way this action 
is defined. 

• [Filter]: this button allows you to filters certain actions. 

• [History]: this buttons allows you to consult an action’s history. Select an scheduled action from the list and 
click this button.  

• [Quick]: this button allows you to add a quick action to the schedule list. 

• [Refresh]: this button allows you to refreshe the list of actions and removes the actions that have already 
been executed and that, therefore, do not need to remain in this list. 

• [Cancel]: this button allows you to close the schedule window. 

 
The [Add], [Quick] and [Filter] buttons are further explained below.  
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4. 1. Add button 

 
 
Upon clicking the [Add] button, a pop-up window appears. In the section ‘Basic settings’, the following options are 
available: 

• Do action at: the date and time at which the action is going to be executed. If the date and time take place 
before the current date and time, the action will be executed immediately. 

• Station: the station for which the action will be executed. 

• Type: type of action. There are 5 types: 

• Call 

• Report: for more information about Reports see Appendix A. 

• Export: for more information about Exports see Appendix B. 

• Quit: to close the sceduler. 

• Service: for more information about Services see Appendix C. 

• Action: the actual action. These are different according to the selected type in the previous step. 

 
To add reports see 7.3.1 Reports. 
To add exports see 7.3.2 Exports. 
To add services see 7.3.3 System services. 

 
 

http://www.micrelec.be/


 

 

TMS GUI Manual v2  pag. 15 / 77 

 www.micrelec.be 

 
 
The next block of settings are the ‘Advanced settings’. On the screenshot above, an anomalities report is added for 
station 1 which is executed at the specified time. 
The ‘Frequency’ field shows when the action has to be executed: 

• Every minute 

• Every 15 minutes 

• Every hour 

• Every day 

• Every week 

• Every month 

 
The ‘Frequency’ field uses the following format MMDDhhmm: 

• mm: number of minutes (can go up to 60) 

• hh: number of hours (can go up to 24) 

• DD: number of days (can go up to 31) 

• MM: number of months (can go up to 12) 

 
For example when an action needs to be executed every 2 days, 3 hours and 20 minutes, the value in the 
‘Frequency’ field has to be 20320. 
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When you specify a frequency, it is mandatory to specify the ‘Repeat until’ field. Here, you will determine for how 
long TMS has to execute this action taking into account the frequency that was set in the previous field. 
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Here are some examples concerning the frequency and date/time:  

 
1.  

 
 
In the example above, the user specified to make a report including tank levels and deliveries for station 1. Note 
that  the ‘Only between’ fields have also been specified.  
 
2.  

 
 
In this example, the selected action needs to be executed every 15 minutes every day from 08:00 until 16:00. 
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3.  

 
 
In this example, the user specified a department export for station 1. Note that the ‘Not on’ field has also been 
specified. This action will be executed every day except on Saturday and Sunday. 
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The user can also specify to create a report or export for a certain number of cutovers by clicking the [ ? ] button in 
the ‘Report/Export’ section. 

 

 
 
The window ‘Cutover details’ will appear. It contains a list of all the cutovers with a start and end date/time. 
 
In the example below, an export file has to be created for all the cutovers starting from 24/05/2005 until (and 
including) a certain date. Therefore, make sure to select the cutover number 161 to include the 24/05 report.  

 

 
 
In the field ‘Include’ (see example below), it is also mandatory to enter the amount of cutovers that are needed in 
the export file. 
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The comment field in the ‘Dynamic Options’ section can be used to enter remarks for other users to read.  
For example, when a certain action needs to be put on hold, the user can enter a reason and his username in this 
field.  
This is useful when different users are using the TMS to schedule actions. 
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4. 2. Quick button 

 
 
In the example above, the quick action “00 Export tank details” for station 1 will be added to the scheduler. 
 
This quick action contains a call and an export. When it is added to the scheduler, there are 2 actions appearing in 
the list and being executed. 

• The first action is a call: ‘Req actual tank details’ which requests the data. 

• The second action is an export: ‘Last tank readings, 15 tanks’ which makes the export. 
 
To add quick actions see 5.3.4 Quick. 

 

 
 
 
 
 
 
 

http://www.micrelec.be/


 

 

TMS GUI Manual v2  pag. 22 / 77 

 www.micrelec.be 

4. 3. Filter button 

 
 
When many actions have already been scheduled, it can be useful to use the filter to search for certain actions. 
There are 4 types of criteria: 

• Do action at: specify the date and time for the actions that you want to see. 

• Station: specify a station. The application will filter all the actions for this station. 

• Type: specify a type of action and the action itself. The application will filter all the actions for the selection. 

• Hold: specify whether you want to see all the actions on hold or not. Tick the box that comes after ‘Hold’. 
 
First, tick the boxes of the criteria you wish to use. Then specify the filter as explained above.  
You can combine different filters. 

 
The result of the filter is shown in the scheduler. The [Filter] buttons is now red. This is just an indication to show 
whether the filter is being used or not. 
 

 
 
When you have used the filter, the buttons [Hold All], [Del. All] and [Reschedule All] are available. 
These buttons are similar to the ones above: 

• [Hold All]: this button allows you to put all the actions on hold (or to reactivate them). 

• [Del. All]: this button allows you to delete all the actions. Confirm by clicking the [OK] button. 

• [Reschedule All]: this button allows you to reschedule all possible actions. 
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5. View menu 

5. 1. Report 

 
 
When you click the [Report] button in the View menu, you will be able to open a report file. Report files are located 
in the \spool directory from TMS. 

 

 
 
Each report file has a specific starting character. To make reports see 7.3.1. Reports. 
After opening a report file, the content appears in the new window. Note that the printer icon is enabled now. You 
are now able to print this file. 
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5. 2. Export 

 
 
After clicking the [Export] button in the View menu, you will be able to open an export file. Export files are located 
in the \export directory from TMS. 

 

 
 
Each export file has a specific starting character. To make export see 7.3.2. Exports. 
This is a preview of an export file. Note that the printer icon is enabled now. You are now able to print this file. 
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5. 3. Logging 

 
 
After clicking the [Loggin] button in the View menu, you will be able to open a log file. Log files are located in the 
\log directory from TMS. 

 

 
 
Each log file has a specific starting character.  
This is a preview of an log file. Note that the printer icon is enabled now. You are now able to print this file. 
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5. 4. Tank status 

 
 
After clicking the [Tank status] button in the View menu, a system warning will appear when you have not selected 
a station first. Select a station following the steps described in 3.1. Station selection. 
 

 
 
After selecting a station, the station number and name are displayed in the icon bar. 
 
After clicking the [Tank status] button, a pop-up window will appear showing all info on the tanks present on site. 
See example below. 
 

 
 
If this screen is empty, you should start a call action to retrieve data from the station.  
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5. 5. Fuel price overview 

 
 
First, select a station or a group. 
After clicking the [Fuel price overview] button in the View menu, a pop-up window will appear showing the fuel 
price overview (last received prices). See example below. 
 
Explanation of the buttons: 

• Last received: this button allows you to see the last received fuel prices overview. 
When the field ‘Historical prices received at the latest on’ is completed, the last received fuel prices overview 
starting from this date/time are shown. 

• To send: this button allows you to see the last ‘To send’ fuel prices overview. 

• Last sent: this button allows you to see the last ‘Last send’ fuel prices overview. 
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6. Edit menu 

6. 1. Terminal/Dispenser management 

This function allows you to enable/disable terminals (OPT, Attended, Console, Test) and dispensers even at nozzle 
level. This can be useful when a dispenser is broken or a hose needs to be replaced. The SC configuration needs 
to be available in order to make changes on site. 
 

 
 
After the clicking the [Teminal/Dispenser Management] button in the Edit menu, the windows below pop up. If 
you had not selected a station before, you can select one in the new window using the drop-down list below ‘Select 
station’. 
The button [Last Req./Send] allows you to switch between the last send and the last requested information. The 
text at the top of the window specifies if the information shown is the requested information or the send information. 
The button [Undo] allows you to undo all the changes since the last save. 
The button [Cancel] allows you to close this window. 
When making changes, confirm the modification with the button [Ok]. 
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To enable/disable a terminal or dispenser, select the correct line. Then right click to enable or disable, like in the 
example below. 
 

 
 
When a terminal/dispenser is disabled, it will be preceded by an X.  
In the example below, ‘Terminals’ are also marked with an X on a grey background. This means that a sub item is 
disabled. 

 

 
 
It is possible to disable an entire dispenser or terminal, as shown below (3 multi pro is disabled). Make sure to 
select the main item, instead of a sub item. 
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When all nozzles from a dispenser are disabled, an X (without a grey background) appears next to that dispenser. 
All the nozzles have to be enabled again one by one in order the enable the entire dispenser. 

 

 
 
Click the [OK] button to confirm the modifications. TMS will ask if the changes should be saved in the database. 
When you click [Yes], the changes will be saved in the database but they will not be send to the station. You can 
use a call action – Send act/blck dispen,terminal to send the information to the station. 
You can also check the checkbox ‘Schedule a call?’ to schedule a call action on hold.  

 

 
 
WARNING: Dispensers or terminals blocked by TMS can only be unblocked by TMS! 
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6. 2. Commercial profiles 

Commercial profiles are an easy way to activate a variety of prices on sites depending on certain formulas based 
on a set of official prices.  
 

 
 
After clicking [Commercial profiles] in the Edit menu we see the window as below. 

• [New]: this button allows you to add a new commercial profile. 

• [Delete]: this button allows you to delete the selected profile.  

• [Linked sites]: this button allows you to show the sites linked to this profile. 

• [Cancel]: this button allows you to cancel the change you made or to leave the window. 

• [Save]: this button allows you to save a new or existing profile. 

• [Close]: this button allows you to close the commercial profiles window.  
 
See also 8.1. Formulas. 
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6. 2. 1. Save button 

When you want to create a new commercial profile, you will need to enter a profile ID (this is a number) and a 
profile name. Then, you can select which formula you want to use for the different products: select the product and 
select a formula from the drop-down list at the bottom of the window. 
To make formulas see 8.1. Formulas. 
 

 
 
When you fail to enter a profile ID, the following error message will appear. 

 

 
 
After entering all the correct info, click the [Save] button to save the commercial profile. 
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6. 2. 2. Linked sites button 

When selecting a commercial profile, you can click the [Linked sites] button. A new window pops up with a list of 
all the stations linked to this profile. 
To add a commercial profile to a station see 7.1. Station. 
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6. 3. Fuel prices 

This function is used to send fuel prices to a site. When only 1 station has been selected, the fuel prices as entered 
will be adjusted. When a group of stations has been selected, the fuel prices will be send taking into account the 
commercial profiles each station is linked to. 
 

 
 
First, select a station or a group. 
After clicking [Fuel prices] in the menu Edit, the window below pops up. 
This window shows the last requested fuel prices, the last sent fuel prices, and the date and time when they were 
last requested. 
 

 
 
When the prices for a certain station need to be changed, you can enter the new prices in the last column. Confirm 
with [Ok]. TMS asks if the changes need to be saved in the database. When clicking [Yes], the prices are saved in 
the database but they are not updated at the station. A call action – Send wet prices needs to be scheduled to send 
the new prices stored in the database to the specified station. 

 

 
 
It is also possible to send the prices to the station immediately with checking the checkbox ‘Schedule call’ at the 
button of the window as shown in the example above. 

 
When this box is checked, call on hold has been added to the scheduler. To activate this call, select the correct 
action and click the button [Hold]. The prices will be sent to the station selected in the previous steps. 
The call is first put on hold because it will modify prices at the station. This setting allows you to check the action 
before activating it, so as to avoid errors. 
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6. 4. Pre-init wet fuel prices 

This function is used to adjust pre-initialised fuel prices. These are fuel prices that have been programmed to 
change on a given time. When only 1 station has been selected, the fuel prices as entered will be adjusted. When a 
group of stations has been selected, the fuel prices will be send taking into account the commercial profiles each 
station is linked to. 
 

 
 
You can send pre-initialised fuel prices by clicking [Pre-init wet fuel prices] in the Edit menu. 
The layout of the window is similar to the Fuel prices window in 6.3 Fuel prices. The only difference here is that you 
will have to specify the date and time on which the prices need to be adjusted in the ‘Change at’ field. 

 

 
 
When you do not complete the ‘Change at’ field, the following error will be appear. 

 

 
 
After entering everything correctly, confirm by clicking [OK]. TMS will then ask if the data needs to be saved in the 
database. When clicking [Yes], the prices are saved in the database but they are not updated at the station. A call 
action – Send wet pre-init prices needs to be scheduled to send the new prices stored in the database to the 
specified station. 
 
When checking the checkbox ‘Schedule call’, as shown on the screenshot above, the pre init fuel prices will be 
send immediately. 
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When this box is checked, call on hold has been added to the scheduler. To activate this call, select the correct 
action and click the button [Hold]. The prices will be sent to the station selected in the previous steps. 
The call is first put on hold because it will modify prices at the station. This setting allows you to check the action 
before activating it, so as to avoid errors. 
There is a possibility to change this parameter so the call will not be put on hold first. To change this setting see  
7.4 Parameters. 
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6. 5. Site parameters 

This function is used to configure dynamical parameters for the site. For more information about these parameters 
consult Reconciliation.doc. 
 

 
 
When clicking the [Site parameters] button in the Edit menu, the window below will appear. 
The button [Last req. /send] allows you to switch between the last requested and last send parameters.  
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7. Define menu 

7. 1. Station 

Here, you will be able to manage defined stations and to add new ones. It is also possible to link a commercial 
profile to a station. 
 

 
 
After clicking [Station…] in the Define menu, the window below will pop up. The window contains a list of all the 
defined stations and some of their information. 

 
• [Edit]: this button allows you to edit an existing station. 

• [Add]: this button allows you to add stations to the list. See also 7.1.1. Add button. 

• [Delete]: this button allows you to delete a selected station. See also 7.1.2. Delete button. 

• [Reinitialise]: this button allows you to reset all site history and data.  

• [Quick Action]: this button allows you to launch an action for a selected station. 

• [Action History]: this button allows you to consult the action history of the selected station. 

• [Find Site Nr]: this function allows you find a station. Enter a value in this field and press [ENTER] or click 
the binoculars button. The station you were looking for is selected. 

• [Filter]: this button allows you to display stations which meet specific settings. See also 7.1.3. Filter button. 

• [Add Group]: this button allows you to create groups. Move the stations belonging to the new group using 
the arrows. Enter a name in the field at the top of the screen. Click [Save].  

• [Close]: this button allows you to close this window. 
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7. 1. 1. Add button 

The Basic tab: 

 

 
 
Here, you will find all the basic data needed for a station to be added: 

• Site Nr.: number of the site 

• Name: name of the site 

• Site ID: ID given to the site. 

• Site type: there are 3 types of sites. 

• Micros 

• Tokheim 

• Dummy: not in use 

• Password: not used. The value will always be ‘00000000’.  

• PSTN/ISDN nr.: modem number from the station. 

• Node number: used when more devices are connected on 1 modem line. 

• Company: the station’s company name. 

• Scheduler Id: used when working with different schedulers. 

• Communication Media: Micrelec defines what Net 0 and Net 1 means. 

• Commercial Profile: used to link a station to a commercial profile. (see 6.2. Commercial profiles) 

• CMS SiteGroup: to add this station to a site group. You can select a Site Group when using the CMS 
software. 

 
Click [Save] to finish the creation of the site. Click [Close] to close the window. 
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The Address tab: 

 

 
 
This is general information about the station. 

 
The TCP/IP tab: 

 

 
 
Here, you will find the following fields:  

• Login: login to connect onto the system. 

• Password: password to connect onto the system. 

• Domain: domain URL 

• FTP Server: server address if used 

• IP address: IP address when using TCP/IP communication. 

• Login: login to connect to the FTP or VPN 

• Password: password to connect to the FTP or VPN 

• IP Address Proxy server: server IP address if used 
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7. 1. 2. Delete button 

This button allows you to delete a selected station.  
Select the station(s) you want to delete and click the [Delete] button. The marked stations will have a red X at the 
beginning of the line. You can mark several stations for deletion at once. After you are done selecting stations to be 
deleted, confirm the selection with the [Confirm] button.  
TMS will count the stations marked to be deleted and will ask whether to launch the operation or not. 

 

 
 
NOTE: All data about a station will be lost when it is deleted. 

7. 1. 3. Reinitialise button 

This button allows you to reset all site history and data. 
Select the station(s) you want to reset and click the [Reinitialise] button. The selected stations will have a red 
marking at the beginning of the line. You can mark several stations for reinitialization at once. After you are done 
selecting stations, confirm the selection with the [Confirm] button.  
TMS will count the stations marked to be deleted and will ask whether to launch the operation or not. 
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7. 1. 4. Filter button 

This button allows you to find stations. 
There a several criteria: 

• Company: the station’s company name. 

• Group of stations: the group a station belongs to. 

• Site Nr. from – to: the range of site numbers you want to have displayed. 

• Scheduler Id: used when working with different schedulers. 

• Commercial profile: the profile a stations belongs to. 

• Part of IP Address: a part of the IP address of the station. 

• Part of PSTN/ISDN: a part of the modem number of the station. 

• Part of VPN address: a part of the VPN address of the station. 

• Site Type: type of site 

• Micros 

• Tokheim 

• Dummy: not used 
 
Click [Apply Filter] to launch the search filter.  
Click [Clear Filter] to clear all fields. 
Click [Cancel] to cancel the search filter. 
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7. 2. Groups 

This function is used to create groups. Several stations can be added to a certain group. This is useful when the 
same action has to be executed for several stations. 
 

 
 
After clicking [Groups…] in the Define menu, the screen below pops up. The window contains a list of all the 
existing groups. 

 
• [Edit]: this button allows you to edit a group. This includes removing stations from the group, adding stations 

to the group and changing the group’s name. 

• [Add]: this button allows you to add a new group. 

• [Delete]: this button allows you to delete a group. Note: this will not the stations in the group. 

• [Combine]: this buttons allows you to combine groups. 
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7. 2. 1. Add button 

When adding a group, you need to specify the group name and the stations that need to be added to this group. 
Multiple stations can be selected using the CTRL button on your keyboard. By clicking the arrow button ( → ) 
stations are added to the group. When the user selects stations under the group and clicks the arrow button ( ← ) 
the user is removing stations from the group. 
 

 
 

7. 2. 2. Delete button 

It is possible to delete multiple groups at once (the stations in the group will not be removed). To delete, you can 
click group(s) one by one and click [Delete] every time. The groups selected for deletion have a * in front of them. 
 
After clicking the [OK] button the groups with a * in front of them are removed. 

7. 2. 3. Edit button 

This button allows you to edit existing groups.  
Moreover, with this button you can also copy existing groups. Open an existing group, enter a new group number 
and save. The existing group will be copied and saved with a new group number.  
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7. 3. Actions 

7. 3. 1. Reports 

There are a few predefined reports. However, it is also possible to customise reports. 
 

 
 
After clicking [Actions] / [Reports] in the Define menu, the window below pops up. You will see a list of all existing 
reports. 

 
• [Edit]: this button allows you to adjust an existing report. 

• [Add]: this button allows you to create a new report. 

• [Delete]: this button allows you to delete the selected report(s). 

• Group: this drop-down list allows you to filter the reports based on Groups.  

• [Cancel]: this buttons allows you to close this window.  
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7. 3. 1. 1) Add button 

After clicking the [Add] button, you will see a list of components to be included in the new report. 

 

 
 
To create a report, you can move the blocks that are relevant to the new report using the arrow ( → ) button. 
Then, enter a name for the report. You will also need to specify the Id (top right corner of the window). This 
character is the first character for the file name of the report. 

 

 
 
Click [OK] to save the new report. You can now schedule this report to be executed. See also 4. Schedule menu. 

 

 
 
For more information about the reporting components, see Appendix A. 
 
NOTE: by entering certain commands in the ‘Static Options’ field, one can be able to change an action’s behaviour. 
This is an advanced feature and will not be used.  
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7. 3. 2. Exports 

There are a few predefined exports. However, it is also possible to customise own exports. Exports are used to 
transfer data into a third party application (like a bookkeeping program). 
 

 
 
After clicking [Actions] / [Exports] in the Define menu, the window below pops up. You will see a list of all existing 
exports. 
 

• [Edit]: this button allows you to adjust an existing export. 

• [Add]: this button allows you to create a new export. 

• [Delete]: this button allows you to delete the selected export(s). 

• Group: this drop-down list allows you to filter the exports based on Groups.  

• [Cancel]: this buttons allows you to close this window.  
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7. 3. 2. 1) Add button 

Different types of exports can be added based on existing exports. 
 

 
 
Some fields need explanation 

• Blank undefined fields: when certain fields have not been completed, it is possible to keep them blank by 
checking this checkbox. If this checkbox is not ticked, the blank fields will have value 0 in the export file. 
When this box has not been checked, you will get the following result: 
 

 
 
 When this box has been checked, you will get the following result: 

 

 
 

 
• Use field separator: this options allows you to define the separator used between every field in the export. 

Check this box and add a separator in the field below. 

• File extension: this options allows you to specify the extension for the export file. 

 
For more information about Exports see Appendix B. 

 
NOTE: by entering certain commands in the ‘Static Options’ field, one can be able to change an action’s behaviour. 
This is an advanced feature and will not be used.  
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7. 3. 3. System services 

There are a few predefined system services. However, it is also possible to customise own services. System 
services are used for maintenance, backup, accessing the backoffice, etc. 
 

 
 
After clicking [Actions] / [System services] in the Define menu, the window below pops up. You will see a list of 
all existing exports. 
 

• [Edit]: this button allows you to adjust an existing service. 

• [Add]: this button allows you to create a new service. 

• [Delete]: this button allows you to delete the selected service(s). 

• Group: this drop-down list allows you to filter the services based on Groups.  

• [Cancel]: this buttons allows you to close this window.  
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7. 3. 3. 1) Add button 

After clicking the [Add] button, you will see a list of components to be included in the new service. 
 

 
 
To create a service, you can move the blocks that are relevant to the new service using the arrow ( → ) button. 
Then, enter a name for the service.  
In the example below, a service was created for DB Cleanup. 

 

 
 
Click [OK] to save the new report. You can now schedule this service to be executed. See also 4. Schedule menu. 

 
 
For more information about the service blocks see Appendix C. 

 
NOTE: by entering certain commands in the ‘Static Options’ field, one can be able to change an action’s behaviour. 
This is an advanced feature and will not be used.  
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7. 3. 4. Quick 

There are a few predefined quick actions. However, it is also possible to customise own actions. 
See also 3.3. Quick action and 4.2. Quick button. 
 

 
 
After clicking [Actions] / [Quick] in the Define menu, the window below pops up. You will see a list of all existing 
quick actions. 

 
• [Edit]: this button allows you to adjust an existing quick action. 

• [Add]: this button allows you to create a new quick action. 

• [Delete]: this button allows you to delete the selected quick action(s). 

• Group: this drop-down list allows you to filter the quick actions based on Groups.  

• [Cancel]: this buttons allows you to close this window.  
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7. 3. 4. 1) Add button 

After clicking the [Add] button, the following window appears.  
 

 
 
First enter a name for the quick action. Then, choose a type of action and specify which action has to be executed. 
It is possible to define up to 3 actions to be executed subsequently. 
For example, a tank status report is needed. First, TMS will need to extract data from the station. Therefore, we will 
need to schedule a call action – Req. actual tank details. Then, TMS will need to make a report. Therefore, we will 
need to schedule a report action – Level details. 

 

 
 
Click [OK] to save the new quick action. You can now schedule this action to be executed.  
See also 3.3. Quick action and 4.2. Quick button. 
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7. 3. 5. Call 

There are a few predefined calls. However, it is also possible to customise own calls. 
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8. Setup menu 

8. 1. Formulas 

Formulas can generally be used for all kinds of mathematical operations in TMS. Currently, however, formulas are 
only used for commercial profiles. 
 

 
 
After clicking [Formulas] in the Setup menu, the window below pops up. You will see a list of all existing formulas. 

 
• [Add]: this button allows you to create a new formula. 

• [Delete]: this button allows you to delete the selected formula (s). 

• [Usage]: this button allows you to consult in which commercial profiles a formula is being used. 

• [Cancel]: this buttons allows you to close this window.  

• [Close]: this button allows you to close this window.  
 
At the bottom of the screen, you will see the following information about the highlighted formula: number, 
description, factor and function.  
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8. 1. 1. Add button 

After clicking the [Add] button, you will see green fields at the bottom of the window. 
 

 
 
Fill in a number and a formula description. 
Then, enter a factor. This is the value that will be added or subtracted from the current prices on site. 
Finally, enter a function. Choose whether the factor should be added or substracted. 

8. 2. EFT Setup 

This function contains EFT related information. 
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8. 3. User management 

In this menu, you will be able to create and manage users. 
 

 
 
After clicking [User management] in the Setup menu, the window below pops up. 
 

• [Edit]: this button allows you to adjust an existing user/profile. 

• [Add]: this button allows you to create a new user/profile. 

• [Delete]: this button allows you to delete the selected user/profile(s). 

• [Cancel]: this buttons allows you to close this window.  

 
There are 2 tabs in this window: user profiles and users. 
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8. 3. 1. Tab User Profiles 

There are 5 different levels of user profiles: 

• Administrator profile: highest level, access to all TMS GUI resources 

 
• Level 1 profile: access to action scheduling, station/action definition, fuel prices,  

SC parameters, Commercial profiles, viewing, action scheduling.  

 
• Level 2 profile: access to station/action definition, fuel prices, SC parameters, Commercial profiles, viewing, 

action schedulation  
 

• Level 3 profile: access to fuel prices, SC parameters, Commercial profiles, viewing, action schedulation  
 

• Level 4 profile: only access to view resources. Other profiles can be created through Administration profile.  
 
Users can be created through an administrator profile and are linked to one or more existing profiles. A user must 
be linked to a profile to obtain access rights to TMS. 

 
To add a new profile, click [Add].  
To edit an existing profile, click [Edit]. 
You will see the screen below. Here, you will be able to determine which actions can be performed by a user with 
that profile. 
Right click the action and choose [Allow] or [Block]. When a menu is blocked, it is not possible to enter any of the 
underlying menu items. 
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8. 3. 2. Tab Users 

In this tab, you will be able to create users based on user profiles. 
 
To add a new user, click [Add].  
To edit an existing user, click [Edit]. 
You will see the screen below.  
 
Here, enter a user name and enter a login. The user Id is generated automatically. 
Then, specify whether the user is active or not. When a deactivated user is used to log in, you will see the error 
message below. 
Finally, enter a password and a confirmation and select a linked user profile. 
 

 
 

 

8. 3. 3. User management related information 

8. 3. 3. 1) Logging into file 

For every successful login, a file will be added in the %TMSROOT%\LOG directory with the following name format 
SYSMMDDhhmm.log where: 
 

• MM is the month number. 

• DD is the day number. 
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• hh is the hour when the user logged in. 

• mm are the minutes when the user logged in. 

 

8. 3. 3. 2) User action logging 

Following actions will be logged in TMS User logging: 

 
• User log in/out 

• Action scheduling: Add, Delete, Edit 

• Site controller parameter modifications 

• Terminal/dispenser/nozzle management 

• Fuel price editing + commercial profile editing 

• Station Definition: add, delete, modify 

• EFT related modifications 

• Admin tasks 
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9. Window menu 

9. 1. Cascade 

When selecting this option, the windows opened in the TMS main window will be shown in cascade form.  
 

 

9. 2. Tile horizontally 

When selecting this option, the windows opened in the TMS main window will be tiled horizontally.  
 

 

9. 3. Tile vertically 

When selecting this option, the windows opened in the TMS main window will be tiled vertically.  
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10. Help menu 

10. 1. About 

When clicking [About] in the Help menu, the window below will pop up. 
In this window, you will see the following information: 
 

• Version of the software release. (here 5.6.0.0) 

• Type of installed TMS. (here multi-company) 

• The number of defined stations. (here 10) 

• The Torex Retail N.V. phone number. 

• The Torex Retail N.V. fax number. 
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Appendix A:  REPORTING COMPONENTS 

A0 Header 

 Shows from what station (or group) this report is created from. 
Shows when this report is created (date and time). 
Shows when the last data call is made to be able to make this report. 
Shows start and end time/date from the last closed period. 

A1 Software version 

 Sows the software version. 
Shows when the configuration (SC) has been adapted for the last time. 

A2 Dispenser/nozzle sales, indexes (non-resettable totalizers) 

 Shows per dispenser, per nozzle: 
Total amount (Money) 
Total volume of fuel dispensed 
Total number of transactions 
TooMuch: When the dispenser is pre-paid for 20€ of fuel but only 15€ is dispensed 
because the tank in your car is full, then the user is credited and remaining 5€ is put in 
TooMuch. (Usually Outdoor sales with BNA) 
TooLess: When the dispenser is pre-paid for 20€ of fuel but it is unable to stop exactly 
and overshoots to 20,15 (Badly working valve,..) then the remaining 15c is put in TooLess. 
IndexAmount: Amount of money from all the sales since the installation of the dispenser.  
IndexVolume: Amount of fuel from all the sales since the installation of the dispenser. 

A3 Terminal Sales 

 This shows the total amount, volume and number of transactions per terminal. 
There’s also a general total shown of the amount, volume and transactions 

A4 Level Details (period related) 

 For every tank on the site is shown: 
The type of product in the tank. 
The capacity of the tank. 
 
Measured data: 
Height of the water level in the tank (millimetres). 
Height of the fuel level in the tank. 
Total volume of water in the tank (litres). 
Total volume of fuel in the tank (measured by LGS) 
Status: Status from the level gauge. 
 
Calculated data: 
Theoretical volume of fuel in the tank derived from registered deliveries and performed 
fuel sales 
 

A5 Fuel delivery details 

 Up to 4 last deliveries per tank are shown with the following data: 
Date and time of the delivery. 
Volume of the delivery (litre). 
Date and Time of delivery user input (when deliveries are entered by user) 
Delivery Volume as entered by the user  
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Note: The last 4 deliveries shown are related to the totalisation period for which the report 
is generated.  
Deliveries happening during the currently running and yet unclosed period will not be 
shown here. 

A6 Articles sales  

 Per article: 
Article number. 
Article name. 
Sell Price for this article. 
Total amount sold 
Number of items sold. 
Total amount of returned items. 
Number of returned items. 
A total per column. 
This data is only available for sites with integrated POS 

A7 Department sales 

 Per department: 
Total Amount sold. 
Number of sales. 
Total amount of the returned items. 
Number of the returned items. 
A total per column. 
This data is only available for sites with integrated POS 

A8 Mode of payment  

 Per mode of payment (MOP): 
Number of the mode of payment. 
Description of the mode of payment. 
Exchange rate (in case of foreign currencies) 
Total amount of money tendered with this MOP. 
Number of transactions where MOP was used. 
Total amount of returned money 
Litres of fuel (if applicable) 
A total per column. 
This data is only available for sites with integrated POS 

A9 Mode of payment (per operator shift) 

 Per period, per POS (Point of sale), per shift (operator number, operator name, shift 
number, date and time for start of the shift): 
Number of the mode of payment. 
Description of the mode of payment. 
Exchange rate (in case of foreign currencies) 
Total amount of money tendered with this MOP. 
Number of transactions where MOP was used. 
Total amount of returned money 
Litres of fuel (if applicable) 
A total per column. 
This data is only available for sites with integrated POS 
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AB Actual level details 

 Last known tank level details per tank: 
 
The type of product in the tank. 
The capacity of the tank. 
 
Measured data: 
Height of the water level in the tank (millimetres). 
Height of the fuel level in the tank. 
Total volume of water in the tank (litres). 
Total volume of fuel in the tank (measured by LGS) 
Status: Status from the level gauge. 
 
Calculated data: 
Theoretical volume of fuel in the tank derived from registered deliveries and performed 
fuel sales 
 

AC Terminal/Product sales 

 Per terminal, per product : 
Total volume 
Total amount  
Number of transactions 

AE Terminal/MOP sales 

 Per terminal, per MOP (Mode of Payment): 
Total volume 
Total amount  
Number of transactions 

AF Site Configuration 

 Site Controller 
Software version, the last configuration change. 
Per dispenser, per nozzle: 
The number TMS uses for a nozzle. 
Fuel type (product name) 
Per tank: 
Product in the tank. 
Capacity of the tank. 
List of connected nozzles 
Description of the terminals present on the site. 

AG Product Sales 

 Per product used on site: 
Unit price valid at the end of the totalisation period 
Total volume 
Total amount  
Number of transactions 
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AH Department/sub-department Sales 

 Per department/sub department: 
Total Amount sold. 
Number of sales. 
Total amount of the returned items. 
Number of the returned items. 
A total per column. 
This data is only available for sites with integrated POS 

AJ MOP index sales 

 Per index: 
Ex rate: Exchange rate. 
Comb amt: Combined total price (Fuel and Shop). 
Fuel amt: Fuel total price. 
Shop amt: Shop total price. 
For amt: Foreign amount. 

AK MOP index sales (pos) 

 Per POS, per index: 
Ex rate: Exchange rate. 
Comb amt: Combined total price (Fuel and Shop). 
Fuel amt: Fuel total price. 
Shop amt: Shop total price. 
For amt: Foreign amount. 

AL Last eft status poll 

 EFT related report. 

AM Last fuel delivery details 

 Last known 4 deliveries per tank are shown with the following data: 
Date and time of the delivery. 
Volume of the delivery (litre). 
Date and Time of delivery user input (when deliveries are entered by user) 
Delivery Volume as entered by the user  

AN Call Anomalies (Station unspecific report) 

 Report with all what went wrong from the last time this report was last issued. Failed TMS 
actions, exceptions encountered during action execution,… 
Using this report regularly allows for management by exception of all TMS related issues. 

AO Diagnosis last transactions 

 Report with 20 last transactions as retrieved by the diagnostic call  

AQ SC RF-id operator sales 

 Period totals split per operator (per RF-ID card) 
(Available when Fuel Sales Tagging through RF-ID cards is active) 
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Appendix B:  EXPORTS 

Exports made in the context of a call 
During the call TMS fetches data and generates export file(s). 

• POS Data 

• SC Logging 

• Specific data exports during a call 

 
Exports generated from data stored in the database 
Various station calls fetch data from site and store it (also) in the database. Most of the data retrieved from site and 
stored is data related to a site period closure. A period on a site generally covers one day of operation. Stored data 
is then used to generate reports and exports. As only data already present in the DB can be exported, TMS is 
foreseen with features allowing the export to wait until the preceding data retrieval action(s) either succeeded or 
failed.  
 
 
Station specific export files 
Export file is on a per station basis. Export action needs to be scheduled for each station concerned.  
 
Export files with data from all stations per type of data 
Export file is on a data type basis and contains data from all sites. Only one station unspecific export action needs 
to be scheduled.  
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1. POS Data 

 
POS DATA EXPORT FILES. (dynamic binary export) 
 
Calls containing the BE script element retrieve and export the POS Binary Export files. The created files are 
located in the ..\trans directory. 
 
File names follow following logic: 
 
ZZZXXXXY.SSSS 
ZZZ: Fixed, these 3 characters show what the content of the file is 
XXXX: Period number from the SC. 
Y: Sequence number of the POS period within the SC period (the last character). 
SSSS: Number of the station. 
 
All the information in the export files are obtained from the POS.  
One file is created per station, per period, per type of data. 
Content and types of available exports is configured on site on the POS. 
(Can be done through a dedicated TMS call) 
Exported files are located in the ..\trans directory. 
 
This type of export is called binary export. The files are binary at the POS. TMS requests these files and converts 
them into CSV files. 
 
Different types of the export files are: 

- MOP: Method of payment totals of the period. 
- DEP: Department totals of the period. 
- ART: Article movement (sales total per article) over the period. 
- VAT: VAT rates at the end of the period. 
- PTR: Payment details for each sale in the period. 
- STR: Sale details for each sale in the period. 
- DPO: Department totals per shift. 
- STK: Article stock at the end of the period. 
- COM: Manager commission calculation details for the period. 
- CAD: Details of credit account clients (Local accounts or LACC). 
- PCI: Period closure info. 
- NZS  Nozzle Sales 
- TAS  Tank Status and Levels 
- DSH  Dry Stock Operation Header 
- DSL  Dry Stock Operation Lines 
- LTY:  Loyalty info file 

 
For detailed information refer to the dedicated document about POS exports. 

 
2. Site Controller Logging 

 
TA_AN_LG ( = Tank Analysis Logging) 
 
Export is generated by call actions with script element requesting new TA_AN_LG - new records of Tank Analysis 
Log. Used also by Petrol 247 for follow up of the levels in the tanks. 
 
File is located in  ..\export directory, format is CSV and file extension follows the TMS station number.  
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SC_TR_LG ( = Site controller Transactions Logging) 
 
Export is generated by call actions with script element requesting new SC_TR_LG. 
File is located in the ..\export directory, format is CSV and file extension follows the TMS station number. This file 
contains detailed information about each fuel transaction happening on the SC. 
 
There are 2 types of SC_TR_LG files, a short version and a full version. 
Type is configurable trough the TMS.ini file in the root directory of TMS under the option ‘FullSCTRNXLogg’ in the 
block [EXPORT]. 
 
 FullSCTRNXLogg=No  is the short version 
 FullSCTRNXLogg=Yes is the full version 
 
Full version contains more information, like payment and loyalty card numbers used,… 
 
 
LV_CH_LG ( = Level Change Logging) 
 
Export is generated by call actions with script element requesting new LV_CH_LG. 
File is located in the ..\export directory, format is CSV and file extension follows the TMS station number. This file 
contains detailed information about all level changes in all the tanks equipped with the level gauging system. 
 
For more information about Site Controller logging see dedicated documentation (reconcil.doc) 

 
3. Specific data exports during a call 

 
Local invoices/credit notes 
 
Export of invoices/credit notes created on the Site Controller in the sites. Export is generated by call actions with 
script element requesting new invoice records. In the same script, the previously obtained set of invoice records is 
confirmed to the SC. 
 
As a side effect, TMS can re-generate the invoices as they were printed on the site. It can be switched on/off with 
‘GenLocInvoice’ line in the block [REPORT] in the TMS.ini file. 
When 1 is specified then the invoices are generated else only the export file is made. 
 
After this call there is a file added in the \export directory. 
The filename looks like this: 
 
RTINV_s.PRN 
RTINV: ReTail INVoice export file. 
S: TMS session identification. 
 
Tank calibration 
 
The tank calibration files are used to analyse and calculate tank tables. 
To request the tank calibration files the call action – Req tank X calibration logg is needed. 
After one of these calls there is a file added in the specified directory in TMS.ini 
Using the separator also specified in TMS.ini, to separate the columns. 
 
The filename looks like this: 
TA_CA_xx.ssss 

TA_CA_: Tank calibration file 
Xx : Tank number. 
Ssss : The station number. 
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Tank tables 
 
Tank table contains the conversion of height in tank to corresponding volume for multiple points (called straps). 
Tank tables can be sent and requested. Usually a dedicated call is foreseen for each operation. 
After requesting the tank tables the files are located in ..\temp directory. 
 
The filename layout is: 
TA_TB_xx.ssss 

TA_TB_: Tank table file. 
Xx : Ta nk number. 
Ssss: The station number. 

 
When new tank tables need to be send to the site, the files have to be located in the ..\Ssss\send directory of TMS 
with the correct filename. 

   
Last 20000 SC fuel transactions 
 
This export file contains the last 20000 fuel transactions. If the file already exists new records are appended. 
 
Use call action – Request SC transact logging. 
 
After this call a file is created in the ..\trans directory. 
 
The filename layout is: 
TRNmmddn.ssss 

TRN: SC fuel transactions. 
Mm: Month number. 
Dd: Day of month. 
N: PC session number. 
Ssss: The station number. 

 
SC Period fuel transactions 
 
This export file contains the details of all the fuel transactions within a period. 
 
Use call action – Req. POS + SC transactions. 
 
After this call files are created in the ..\trans directory. 
The filename layout is: 
TRSCcccc.ssss 

TRSC: SC period fuel transactions. 

Cccc: SC closure number. 
Ssss: Station number. 
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POS period transactions: Headers and Lines 
 
These export files contain data with all the POS transactions within a period. Header and Lines export files are 
always available together. Record key fields link content of the two files. 
 
Use call action – Req. POS + SC transactions. 
After this call files are created in the ..\trans directory. 
 
Transaction Headers: 
TRHDcccc.ssss 

TRHD: POS period transaction headers. 
Cccc: SC closure number. 
Ssss: The station number. 

 
Transaction Lines: 
TRLIcccc.ssss 

TRLI: POS period transaction line details. 
Cccc: SC closure number. 
Ssss: Station number. 

 
Period transaction headers and lines (both POS and SC) 
 
Export integrates all the transactions done within a period (both SC and POS). 
TMS merges the SC transactions details into the POS transaction details. 
 
First the call action – Req. POS + SC transactions is needed, followed by an export of ZH  type – Merge SC, POS 
transaction Files. Export files are created in the ..\trans directory. 
 
TRHDcccc.ssss, TRLIcccc.ssss 

Cccc: SC period closure number. 
Ssss: Station number. 

 
Periodical article movements 
 
This file contains all the article sales within a period. 
Use call action – Fuel Shop Stock Art. Export file is created in the ..\trans directory. 
 
PARTcccc.ssss 

PART: Periodical article movements. 
Cccc: SC period closure number. 
Ssss: Station number. 

 
For more information see dedicated TMS export documentation. (Telmanxx-xxx.doc.) 
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Station specific export files 

 
60 Nozzles, 15 tanks 
 
Export contains periodic information about the tank levels and nozzle sales, and POS sales ordered by MOP index. 
 
One of the following call actions are needed: Fuel Shop Stock Invoice, Cutover Fuel Stock, Fuel Shop Stock Art, 
Fuel Shop Stock Inv. PI BE, Fuel Shop Stock Inv. PI POSSAL or Fuel Stock Shop. 
 
Export Type: Z6 Sales 60 nozzles 15 tanks, ASCII 
 
Export file is created in the ..\export directory.  
Filename layout: 
Xmmdd_ts 
X: eXport file. 
Mm: Month number. 
Dd: Day of month. 
T: File type, group of export by closure sources. 
 P: TMS. 
 S: Closure started by operator, POS console, fuel console. 
S: Session identification. 

 
 
Last 4 fuel deliveries, 15 tanks 
 
This gives the volume and start time of the last 4 fuel deliveries at the moment of the call. 
 
Export Type: Z7 Fuel deliveries 15 tanks, ASCII 
 
Export file is created in the ..\export directory.  
Filename layout: 
Xmmdd_ts 
X: eXport file. 
Mm: Month number. 
Dd: Day of month. 
T: File type. 
 D: Fuel delivery details. 
S: Session identification. 

 
 
Department export: department and sub department amount, 90 departments 
 
Export of department sales (amounts) and sub-department sales (amounts) of every period. 
 
Export Type:  Z8 Department amounts, ASCII 

Z9 Sub-department amounts, ASCII 
 
Export file is created in the ..\export directory.  
Filename layout: 
SHDSAL_s 
SHDSAL: Fixed part of name. 
S: Session identification. 
 
  

http://www.micrelec.be/


 

 

TMS GUI Manual v2  pag. 72 / 77 

 www.micrelec.be 

4 behaviours of this export are supported, selected through 
TMS.ini file, option ‘ASCIIDeptsMode’ under the section [EXPORT]. 

 
ASCIIDeptsMode Behaviour 

1 Export without department 99 (fuel) information. 

2 Export with department 99 (fuel) information. 

4 Export without department 99 (fuel) information and with currency code 
information. 

5 Export with department 99 (fuel) information and with currency code 
information. 

 
 
Last tank reading, 15 tanks 
 
Export of last collected  tank details. The most recent available info from period closure or from collection of actual 
tank details are exported. 
 
Export Type: ZA Last tank readings, ASCII 
 
Export file is created in the ..\export directory.  
Filename layout: 
STmmdd_s 
ST: Wet Stock details export file. 
Mm: Month number. 
Dd: Day of month number. 
S: Session identification. 

 
 
Last tank readings, XML&SQL 
 
Export of last collected  tank details from collection of actual tank details. 
 
Export Type: X0 Last tank readings XML&SQL 
 
Export file is created in a dedicated directory; at the same time can the data be inserted into an SQL database.  
 
 
TMS DB Table(s) to CSV 
 
Script dependent export capable of exporting content of various TMS DB tables for one site or for a given group of 
sites 
 
Export Type: XA  TMS DB Table(s) to CSV 
 
Export file(s) can be found in the ..\export directory.  

 
For more information about the exports consult dedicated documentation (telmanxx-xxx.doc) 
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Sequential export files 
 
These export files are generated per data type basis (record layout) and contain data from all sites. Only one 
station unspecific export action needs to be scheduled for each export type (file). The way the data is organised 
makes these exports most suitable as interface files for import into an SQL database meant for network wide 
reporting.  
 
2 variants of the sequential export exist. Variant 1 is less extensive.The variant is setup through the TMS.ini file, 
section [EXPORT] option ‘SeqExpModifier’. 

 
File name layout 
 

Export Action Basis Record Content 

SSxxxxxx ZP Seq.cut.data, Shop Sales Period sales per (sub)department 

TMxxxxxx ZQ Seq.cut.data, Terminal MOP Period payments per terminal 

TSxxxxxx ZR Seq.cut.data, Tank Status Tank dipping related data 

FSxxxxxx ZS Seq.cut.data, Nozzle sales Period nozzle sales 

PCxxxxxx ZT Seq.cut.data, Info file Period closure generics 

PFxxxxxx ZU Seq.cut.data, Period fuel sales Period fuel sales 

COxxxxxx ZV Seq.cut.data, Commission Info Period commission details 

FDxxxxxx ZW Seq.cut.data, Fuel Deliveries Fuel Deliveries 

TPxxxxxx ZX Seq.cut.data,Period tank sales Period tank sales 

RFxxxxxx ZY Seq.cut.data, Period Tag Sales Period sales per RF-ID tag 

 
When using one of these exports the station in context of which the export is performed is not relevant. The 
resulting export file contains all available not yet exported information about all stations. An older already once 
exported sequential export file can be re-exported. To do so, export action must be re-launched but needs to 
specify the serial number of the export in the ‘FROM’ field (which is normally left blank).  
 
EXAMPLE: an export file to get information about Nozzle sales is made here. 

 

 
 
  

http://www.micrelec.be/


 

 

TMS GUI Manual v2  pag. 74 / 77 

 www.micrelec.be 

In the export directory of TMS the file FS000073 is created. 
 

 
 
Export is being written into a temporary file SEQEXPxx.$$$ and only upon a successful completion when any data 
were found  is the file name changed. Presence of the temporary file in the export directory indicates failure to find 
any data to export.  
 

 
 
TMS remembers which data went into which export file, and will not export same information twice. When the same 
file (FS000073) needs to be exported again, we note the sequential number of the export – 73. Further we need to 
know what type of export is required. First 2 characters of the file name FS means nozzle sales (see the table here 
above). 
To remake the export file enter the sequence number in the “From:” field in section “Report/Export” and specify the 
right type of export, as shown below. 
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Upon completion the temporary file “SEQEXP01” is deleted and the original file FS000073 is overwritten with the 
re-generated export file. 
 
For detailed information about sequential exports, see dedicated documentation (SequentialExport_x-x.doc) 
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Appendix C: SERVICES 

S0 Clean station specific files 

 DB cleanup. 
Deletes historic cutover data in the database, the number of historic cutover info stored in 
the database depends on the setting of the TMS.ini parameter HistoryDepth = (number of 
cutovers). 

S1 Clean action history SYHISTRY 

 DB cleanup. 
Deletes user scheduled action history in the database, the number of deleted records 
depends on the setting of TMS.ini parameter CleanSyHistor = (number of days). 

S2 Remove old spool files 

 Disk cleanup. 
Deletes old spool files (reports => spool directory) from disk. How many files are kept  
depends on TMS.ini setting CleanSpool = (number of days). 

S3 Remove old logging files 

 Disk cleanup. 
Deletes old log files (log directory) from disk. How many files are kept on disk depends on 
TMS.ini setting CleanCOMLog = (number of days). 

S4 Remove old export files 

 Disk cleanup. 
Deletes old export files (export directory) from disk. Number of files kept on disk depends 
on TMS.ini setting CleanExport = (number of days). 

S5 Remove old requested files 

 Disk cleanup. 
Deletes all received files from stations on disk (\stations\xxxx\recv directories), number of 
old files kept on disk depends on the TMS.ini parameter CleanFileReq = (number of 
days). 

S6 Remove old provider blacklists 

 EFT Server related service. 

S7 Remove old EFT trans. Download 

 EFT Server related service. 

S8 Reallocate EFT Providers 

 EFT Server related service. 

S9 Import station EFT TRNX file 

 EFT Server related service. 

SA Blacklist Import Provider 1 

 EFT Server related service. 

SB Blacklist Import Provider 2 

 EFT Server related service. 

SC Blacklist Import Provider 3 

 EFT Server related service. 

SD Blacklist Import Provider 4 

 EFT Server related service. 

SE Blacklist Import Provider 5 

 EFT Server related service. 

SF Blacklist Import Provider 6 

 EFT Server related service. 

SG Blacklist Import Provider 7 

 EFT Server related service. 

SH Blacklist Import Provider 8 

 EFT Server related service. 
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SI Blacklist Import Provider 9 

 EFT Server related service. 

SJ Blacklist Import Provider 10 

 EFT Server related service. 

SM Tank Readings Trigger Import 

 Process file trigger for fetch and export of site Tank dipping info 

SN Import TMS DB Table(s) 

 Import records of TMS DB tables (passed from other TMS) 

SO Schedule IP Ping Actions 

 Scripted insertion of  actions for site connectivity problems analysis 

SQ IP Ping Station Node(s) 

 Use Ping to analyse site IP connectivity problems 

SV Sum data to Virtual Station 

 Merge Period data from a group of sites as if all came from one virtual site 

SW Fuel price file import ver. 2 

 Imports a fuel price file version 2. 

SX Loyalty info file import 

 Imports a card – points relation file. 

SY Fuel price file import ver. 1 

 Imports a fuel price file version 1. 

SZ Tokheim Station Data Import 

 Import Tokheim period data from local file 

T0 Execute batch file tmsbat0.bat 

 Launch external batchfile TMSBAT0.BAT  

T1 Execute batch file tmsbat1.bat 

 Launch external batchfile TMSBAT1.BAT  

T2 Execute batch file tmsbat2.bat 

 Launch external batchfile TMSBAT2.BAT  

T3 FTP Fuelpos cutovers fetch 

 Import Tokheim FuelPOS period data using FTP 

TB Backup database tables 

 Perform compressed and verified backup of the database 

TC Transfer Files via FTP 

 Scripted file operation(s) with an FTP host 

TD Execute Given Batch file 

 Execute scripted operation using command.exe  

TL Access Site via LMS 

 Build Connection channel, pass control to LMS and wait upon its termination 

TX Reinitialise Station(s) 

 Reinitialise one station or a group of stations – forget all old data 

TY Re-index Historical Data Down 

 Compact DB entries for a given site 

TZ Remove Station(s) from TMS 

 Delete one station or a group of stations and all the related data from TMS 
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